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Introduction 

Audience 

The audience for this manual includes station engineers or technicians working for content 
creators or third-party providers.  

Note Media distributors are required to actively encode using the Nielsen encoding 
methodology per their service agreements with Nielsen. 

Customer Support 

Nielsen Support Location 

Nielsen Encoder Support 800-537-4872 option 2 

Encoders@nielsen.com 

Support Request (form) http://nielsen-encoder-
forum.com/public/documentation/ 

Nielsen Encoder Forum www.nielsen-encoder-forum.com/public/ 

Nielsen Global Technology Center Nielsen 

501 Brooker Creek Blvd 

Oldsmar, FL 34677 

www.nielsen.com 

Conventions Used in this Document 

The following items appear in this document:  

Note This paragraph flags a key point, indicates a tip, or identifies an alternate way of 
performing a task. 

Important This paragraph emphasizes one or more actions that must be followed to avoid a 
catastrophic failure. 

Related Documents 

CableLabs VOD Content Encoding Profiles Specification—specification for encoding AC-3 
files 

CableLabs VOD Metadata Specification Version 1.1—specification for providing metadata for 
AC-3 files 

RTVOD Encoder Installation Quick Start—procedures for installing the encoder applications 
products 
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Understanding RTVOD Encoding and Transferring 
Metadata 

This guide describes concepts and usage of the Nielsen® Watermark RTVOD Encoding Application. 

The Nielsen Watermark RTVOD Encoding Application provides a set of software tools to watermark 
specific types of audio content with RTVOD (Recent Telecast Video On Demand) Nielsen codes.  

Note Throughout this document, NAES II watermarks are referred to as N2 codes and 
Nielsen watermarks are referred to as NW codes or NAES VI codes. 

The RTVOD flag is a final distributor Nielsen watermark, for example, “NW FD” codes with a fixed SID 
(32755 or 32756) that indicates live telecast plus 3 days (C3) or live telecast plus 7 days (C7). It is used 
by the Nielsen backend system. 

RTVOD flags (C3 or C7) are applied only to the pre-watermarked (encoded for linear TV) asset in the 
second or third slots. RTVOD flags cannot be applied to clean content or fully encoded content. For file 
based content, RTVOD metadata (feedpoint) should be sent to the TIC CF – Metadata. RTVOD flag 
encoding will apply only to NW FD codes. It will not insert N2, N2HF, NWCC, or InfoSID codes, moreover, 
SID and checkdigit are not required for RTVOD watermarking since they are already embedded in the 
library. 

The RTVOD Encoding Application is applied to MPEG-2 video files with AC3 audio content which are 
already processed by the VOD Content Encoder.  RTVOD Encoding Application supports ONLY the AC3 
audio transport stream.  The AC3 audio transport stream file extensions are *.mpg, *.m2t, *.trp, and *.ts. 

 

Important The length of the filename of the video asset (e.g. MPEG video file) to be 
encoded must not exceed 100 characters.  Exceeding 100 characters in the 
filename of the video asset can result in failure to encode or failure to properly 
generate metadata (needed for proper crediting).  This is due to a combination of 
limitations imposed by the Windows environment and the way filenames are 
used during video asset processing. 

 

Significant Features of the RTVOD Encoding Application 

The significant features of the RTVOD Encoding Application are: 

 Applied to MPEG-2 video files with AC3 audio content �

 Uses designated RTVOD SID’s �

 Supports only File Based (Off-line)encoding �

 Does Not use SID TIC encoding �

 Does Not use distribution source field in the UI profile set up �

 Allows the user to enter the Client Name in the UI profile set up �
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 Encode RTVOD flag only as a FD.  Does not encode as PC. �

 RTVOD applies only to NW—Nielsen Watermarks (NAES VI).   N2 will not be encoded by �

the RTVOD Encoder. 

 RTVOD SID (flag) encodes into the next available slot, which will be either the 2nd or 3rd �

slot, in the watermark 

 Generates ZIP files that include XML, decoder, and signature logs �

 Sends ZIP file containing the decoder, signature  logs and XML log files to TCF �

 Provide the ability for the user to enter the Asset info for the encoded asset �

Components of the RTVOD Encoder Application 

The RTVOD Encoder Application consists of the following the components: 

 RTVOD Encoder software—an application that encodes, decodes, and can send ZIP files �

directly to the CF or to another computer in your facility for forwarding to the CF. The 
application can be run from a graphical user interface, a command-line tool, 
(ContentCodeCmd), or a file trigger service. 

 File Transfer Manager—optional software used to send ZIP files to the CF from a system �

without the Encoder installed. At scheduled times, the File Transfer Manager Service 
transfers data to the CF. If the connection is disrupted, the manager or service 
automatically retries to send the data. For batch file encoding, you must install the File 
Transfer Manager. 

 ServicesMonitorTool—an application that monitors all services. If a metadata file transfer �

to the CF fails, the tool displays a notification message and restarts stopped services. 
ServicesMonitorTool is automatically installed with the RTVOD Encoder Application 
software and File Transfer Manager Software. The user can configure which services are 
monitored and whether or not the notification message appears. For details, see “RTVOD 
Services Monitor Tool” on page 47. 

Important Both the RTVOD Encoder software component and the File Transfer Manager 
component must be installed together on the Encoding computer.  The Encoding 
computer is the only computer in the single-computer workflow #1, and it is 
“computer #1” in the workflow #2.  The Service Monitor Tool is installed together 
with either component. 
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Transferring Metadata to the Nielsen Collection Facility 

Overview of the File Transfer Options 

To receive credited viewing, the feed-point metadata files that correspond with the encoded 
files must be sent to the CF. You can send these files directly or indirectly to the CF using 
one of two workflows. 

 Workflow 1:  Directly transfer to data collection facility—the Nielsen File Transfer �

Manager Service, running on the same computer as the encoding software, uses SFTP 
(Secure File Transfer Protocol) to directly send files to the CF. 

 Workflow 2:  Indirect transfer to data collection facility—the File Transfer Service running �

on the encoder PC (configured for and using the FTP function) transfers files to a transfer 
server.  Then the transfer server (separate PC from the encoder PC) also running the File 
Transfer Service (configured for and using the SFTP function)  sends the files to the CF. 

Important Install or enable only one FTP application on a computer. 

In addition to these transfer flows, there are different configurations that you can use: 

 Manually sending the metadata files  �

 Using the File Transfer Service to automatically send the metadata files at a scheduled �

interval, which defaults to 15 minutes 

 

The RTVOD Encoding Application sends the metadata in Table 1 in a file to the CF: 

 

Table 1 – Feed-Point Metadata File Contents 

Field Description Comment 

ADIFileName Name of the CableLabs file (if 
any) that is transferred to the 
CF with the Feed-Point 
Metadata file.  

Optional 

Note ADI files are created by 
applications not under the 
control of Nielsen, therefore, 
we cannot guarantee that the 
ADI file is well formed. 

ClientName Client Network Name Max acceptable length for ClientName 
input is 50 characters 

AssetId ID of the encoded content Max acceptable length for AssetId 
input is 20 characters 

AssetName Name of the encoded content Max acceptable length for AssetName 
input is 50 characters 

EpisodeId Unique identifier given to each 
episode of a given series 

Max acceptable length for EpisodeId 
input is 20 characters 
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Field Description Comment 

WatermarkTime The actual system time that the 
watermarking process started, 
expressed as UTC 
(Coordinated Universal Time). 

 

SID Value of the SID that was 
inserted into this asset 
corresponding to C3 or C7 
RTVOD flag 

 

FirstTimeStamp The value of the first 
TimeStamp encoded 

 

LastTimeStamp The value of the last 
TimeStamp encoded 

 

ApplicationName RTVOD Content Encoder GUI  

ApplicationVersion RTVOD Content Encoder GUI 
Version Number 

 

EncoderEngineName NielsenWatermarkEngine  

EncoderEngineVersion NielsenWatermarkEngine 
Version Number 

 

FileSizeBytes Size of the encoded file in bytes  

FileSizeSeconds Approximate duration (in 
seconds) of the encoded file 

 

 
 



 RTVOD Encoding Application User Manual 

 

 10 Nielsen Confidential 

Methods of Transferring Metadata 

There are a few different methods for transferring metadata files to the CF (Collection 
Facility). 

 RTVOD Content Encoder application—if you are directly transferring files from the �

computer that does the encoding to the Nielsen CF, you configure the File Transfer 
Manager from within the RTVOD Content Encoder application itself.  The File Transfer 
Manager will automatically upload the metadata files to the Nielsen CF according to the 
configured time interval. 

 File Transfer Manager application (FTM)—if a separate server is being used to upload �

metadata files to Nielsen, you configure the File Transfer Manager on the upload server 
using the RTVODFTMConfigApp application.   The File Transfer Manager on the upload 
server will automatically upload the metadata files to the Nielsen CF according to the 
configured time interval.  You need to configure the File Transfer Manager on the 
encoder PC to use FTP to transfer the metadata files from the encoder PC to the upload 
server.  The File Transfer Manager on the encoder PC will automatically transfer the 
metadata files to the upload server according to the configured time interval.  You can 
also use the RTVODFTMConfigApp application to upload files to the CF manually. See 
“Transferring Files to CF Using the File Transfer Manager” on page on page 53. 

File Trigger Service 

Overview 

The File Trigger Service (the Trigger Service) performs content-based encoding according to 
parameters defined in a standard XML file (see Table 2 for the parameters and the Appendix 
for the format).  

1. The File Trigger Service opens C:\Nielsen\RTVOD_Encoder\etc\EncoderConfig.txt 
file, from which it reads the PATH of the folder to watch for input XML files. See 
Configuring the File Trigger Service  on page 32 for details on setting these 
parameters. 

2. The Trigger Service validates all encoder parameter settings in the xml file. 

3. The Trigger Service repeatedly checks (once every 15 seconds) for all files that have 
the extension “xml.” 

4. The Trigger Service makes a list of those xml files and processes the xml files, one at 
a time (oldest file first), as follows: 

a. Opens the xml file 

b. Reads the file 

c. Validates all encoder parameter settings in the file 

d. Closes the file. See Table 2 for a complete listing of settings that may be 
extracted from the xml file. 

5. It encodes the specified video source file, using the settings extracted from the xml 
file as its encoding parameters. It uses the same encoding process, creating and 
naming metadata files, and logging status and errors. 

6. When the source file has been encoded successfully, the File Trigger Service deletes 
the corresponding xml file from the drive. 
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7. The File Trigger Service generates metadata files in the configured metadata folder.  
The File Transfer Manager Service detects the metadata files in the metadata folder 
and sends the files to the Nielsen CF according to the configured time interval. 

8. When all files in the xml list are fully encoded, the File Trigger Service repeats steps 
3 and 4. 

9. The File Trigger Service runs until it is manually stopped. 

Note  While the file trigger service is running you should not attempt to use the GUI Encoder nor the 
Command Line Encoder.  This could cause XML data conflict.  If you must use the GUI or 
Command Line Encoder on the same machine as File Trigger Service, then use the File Trigger 
Manager to disable the File Trigger Service before using either encoder. 

 

Standard XML File Parameters 

Table 2 – Parameters Defined for Standard XML File-Encoding 

 

XML Label 
Parameter 
Data Type Parameter Usage 

AdiFileName char * (Optional) full path name of the folder that holds 
CableLabs ADI Asset Distribution Interface files. 

ClientName char * The name of the client related to the asset. If the 
clientname is not found in the trigger file default 
value is used. Max length 50 characters. 

AssetId char * The asset ID to be reported in the metadata file 
for the clip that is about to be encoded.. If the 
asset ID is not found in the trigger file default 
value is used. Max length 20 characters. 

AssetName char * The asset name to be reported in the metadata 
file for the clip that is about to be encoded. If the 
asset name is not found in the trigger file default 
value is used. Max Length 50 characters. 

EpisodeId char * The optional episode ID to be written to the 
feed-point metadata file. If the episode ID is not 
found in the trigger file An XML file whose 
appearance in a specific folder triggers the start 
of a RTVOD-content encode. The path where 
these trigger files are located is identified by the 
"EncoderParamFolder" setting in the 
EncoderConfig.txt file in the RTVOD ROOT / etc 
folder. It may be read from the ADI XML file. 
Max length 20 characters. 
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Requirements 

Environment 

 One or more computers, depending on workflow. �

o Dedicate all computers used to perform RTVOD Encoding solely  to encoding.  

Important To permit the encoding software to run without interference, disable antivirus and 
firewall programs. If this is not possible, add the *.exe files to the “exclude” or 
“trust” list in your antivirus software. For details, see “Encoder Services Are Not 
Running or Repeatedly Fail” on page 61. 

o Do not  install any USB drives on any computer used in performing encoding or 
encoding-related functions. 

o Do not  install software that does not relate to encoding such as email, word 
processing, spreadsheets, etc. 

 Platforms—one of the following Microsoft® Windows® operating systems: �

o Windows 7 Operating System (32 bit and 64 bit) 

o Windows Server 2008 R2 

o Windows Server 2008, 32-bit Operating System 

o Windows Server 2008, 64-bit Operating System 

o Windows Server 2012 Operating System  

 Preferred screen resolution of 1024 x 768 pixels, although 800 x 600 is acceptable �

 TCP/IP connectivity with Internet access �

 Intel Xeon E5 2640 processor (with 8 cores) and 3GB ram is configuration tested for �

better RTVOD encoding performance. 

RTVOD Encoder App Package 

The installation package for the RTVOD Encoder App includes the following items: 

 User Manual �

 Installer �

 RTVOD Content Encoding �

 File Trigger Service �

 GUI Encoder Interface �

 Command Line Encoder Interface �

 File Transfer Manager Service �
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Digital Assets 

Digital Assets with the following conditions will not be encoded and error conditions will be 
logged by the RTVOD Encoder App: 

 Clean Content (content that has no Nielsen watermarks) – Error �

 Pre-encoded with RTVOD Flag – Error �

 Fully Encoded (content where all Nielsen watermark code slots are already used) - Error �

 

 

Important The RTVOD Encoder Application WILL NOT encode fully encoded content, clean 
content, or content pre-encoded with the RTVOD Flag.  

Supported Formats 

 MPEG-2 transport stream files with audio stream in AC3 format conforming to CableLabs �

Content Encoding Specification MD-SP-VOD-CEPT-I01-040107. 

Note The RTVOD Content Encoder does not support encoding of MPEG files with 
PCM. 
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Installing the Software Applications 

Important To permit the encoding software to run without interference, disable antivirus and 
firewall programs. If this is not possible, add the *.exe files to the “exclude” or 
“trust” list in your antivirus software. For details, see “Encoder Services Are Not 
Running or Repeatedly Fail” on page 61. 

As you review the procedures in this section, keep in mind that there are two results we want 
from the process: encoded files to be provided for viewing and transfer of metadata files to 
the Nielsen CF to enable crediting of viewing. 

Installing the RTVOD Encoder Application 

1. Insert the installation CD on a computer. 

2. Browse to the drive. 

3. Right-click and run the setup file autorun.exe as administrator on the computer. 

 

 

Figure 1 – Running encoder application setup as administrator 
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4.  The Nielsen RTVOD Content Encoder Install CD window appears. 

 

Figure 2 – Encoder Install CD Window 

5. Click the button “Install RTVOD Content Encoder. 
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6.  The Nielsen RTVOD Content Encoder InstallShield windows appear. 

 

 

 

Figure 3 – Encoder InstallShield Installation Windows 
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7. Click Next .  The customer information window appears. 

 

 

Figure 4 – Encoder InstallShield Customer Information Window 

 

 

8. Enter your User  Name and Company  Name. 

9. Click Next .  The window to select the setup type appears. 
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Figure 5 – Encoder InstallShield Setup Type Window 

 

10. We recommend selecting Complete Setup.  Click Next .  The ready to install window 
appears. 

 

Figure 6 – Encoder InstallShield Ready to Install Window 

  



 RTVOD Encoding Application User Manual 

 

 19 Nielsen Confidential 

 

 

 

11. Click Install . The setup status window appears. 

 

Figure 7 – Encoder InstallShield Setup Status Window 

12. A window appears asking to enable modifications to the computer firewall.  Click Yes 
if you are authorizing the modifications. 

 

 

Figure 8 – Encoder InstallShield Feed-point Metadata Firewall Modifications Approval Window 
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13. If prompted, install Microsoft .Net Framework 4. 

 

 

Figure 9 – Microsoft .Net Framework 4 Installation Windows 

14. If Microsoft .NET framework 4 has not been detected on the machine, select I accept 
license terms and click Install to continue installation.  

15. If a newer version Microsoft .NET framework is detected on the machine, click Close 
to continue installation.  

16. If Microsoft .NET framework 4 has been detected on the machine, click Cancel (DO 
Not Repair/Remove ) and continue installation 

17. The Microsoft .NET framework installation complete window appears. Click Finish.  

18. The encoder InstallShield installation complete window appears. Click Finish . 
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Figure 10 – Encoder InstallShield Installation Complete Window 
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Installing the File Transfer Manager (FTM) 

1. From the RTVOD Encoder Install CD Window, click the button “Install File Transfer 
Manager. 

2.  The Nielsen RTVOD FTM InstallShield windows appear. 

 

 

Figure 11 – FTM InstallShield Installation Windows 
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3. Click Next .  The customer information window appears. 

 

 

Figure 12 – FTM InstallShield Customer Information Window 

 

 

4. Enter your User  Name and Company  Name. 

5. Click Next .  The window to select the setup type appears. 
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Figure 13 – FTM InstallShield Setup Type Window 

 

6. We recommend selecting Complete Setup.  Click Next .  The ready to install window 
appears. 

 

Figure 14 – FTM InstallShield Ready to Install Window 
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7. Click Install . The setup status window appears. 

 

Figure 15 – FTM InstallShield Setup Status Window 

8. A window appears asking to enable modifications to the computer firewall.  Click Yes 
if you are authorizing the modifications. 

 

 

Figure 16 – FTM InstallShield Feed-point Metadata Firewall Modifications Approval Window 
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9. If prompted, install Microsoft .Net Framework 4. 

 

 

Figure 17 – Microsoft .Net Framework 4 Installation Windows 

 

10. If Microsoft .NET framework 4 has not been detected on the machine, select I accept 
license terms and click Install to continue installation.  

11. If a newer version Microsoft .NET framework is detected on the machine, click Close 
to continue installation.  

12. If Microsoft .NET framework 4 has been detected on the machine, click Cancel (DO 
Not Repair/Remove ) and continue installation 

13. The Microsoft .NET framework installation complete window appears. Click Finish.  
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14. The FTM InstallShield installation complete window appears. Click Finish . 

 

Figure 18 – FTM InstallShield Installation Complete Window 
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Configuring the Software Applications 

This section covers the following tasks: 

 RTVOD Content Encoder application �

 (Optional) File Transfer Manager application �

 (Optional) File Trigger Service �

Configuring the RTVOD Encoder Application 

Note For instructions on configuring and using the Command Line tool instead of the GUI 
(graphical user interface), see “Encoding Using the Command Line” on page 49. 

1. Restart your antivirus software. 

2. Add the following to the list of “exclude” or “trusted” files in your antivirus software: 

o RTVODFileTrigger.exe 

o RTVODFTMService.exe 

o ServicesMonitorTool.exe 

3. Pick a Workflow model ( see Figure 19 and Figure 20) –  

o Workflow 1: Single computer for encoding and file transfer to the CF 

o Workflow 2: One or more computers for encoding and a separate computer for 
file transfer to the CF. 

 

In Workflow 1 install both the RTVOD Content Encoder and the File Transfer Manager onto 
the same computer.  Configure the File Transfer Manager to send the metadata files to the 
Nielsen Collection Facility. 

 

Figure 19 – Workflow 1 
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In Workflow 2 there can be one or more computers performing encoding and a single 
computer to transfer the metadata files to the CF. 

For each encoding PC, install both the RTVOD Content Encoder and the File Transfer 
Manager onto the same computer.  Configure the File Transfer Manager to send the 
metadata files to the local file transfer server.  Install only the File Transfer Manager onto the 
local file transfer server.  Configure the local file transfer server to send the metadata file to 
the Nielsen Collection Facility. 

 

 

Figure 20 – Workflow 2 
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 (Optional) Configuring the File Transfer Manager Application 

Note Configuring the File Transfer Manager application is necessary if you install the RTVOD 
Encoding application on a separate machine. 

Important The Metadata Folder and Archive Metadata Folder must not be located under 
either the “C:\Program Files\” or “C:\Program Files (x86)\” directory trees.  They 
may be located under other directory trees on the C: drive.  They may be located 
on other hard disks. They may also be located in the default locations. 

Note The default location for Metadata Folder is C:\Nielsen\RTVOD_Encoder\metadata 

Note The default location for Archive Metadata is C:\Nielsen\RTVOD_Encoder\arch_metadata 

 

1. Select the Transfer Mode. 

  

Figure 21 – File Transfer Configuration Window
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2. If the transfer mode is Transfer to Data-Collection Facility , complete the fields shown 
in Table 3. 

Table 3 – Feed-Point Transfer Parameters (Transfer to Data-Collection Facility) 

Field Description 

Metadata Folder The local location of the metadata files to be transferred. 

The default is 

C:\Nielsen\RTVOD_Encoder\metadata 

Archive Folder The local location of the folder where metadata files that 
already transferred are stored. 

The default is 

C:\Nielsen\RTVOD_Encoder\arch_metadata 

Server Address Supplied by Nielsen 

Server Login Supplied by Nielsen 

Server Password Supplied by Nielsen 

Remote Folder Supplied by Nielsen 

 
3. If the transfer mode is Transfer to Local Server , complete the fields shown in Table 4. 

Table 4 – Feed-Point Transfer Parameters (Transfer to Local Server) 

Field Description 

Metadata Folder The local location of the metadata files to be transferred 

Default is 

C:\Nielsen\RTVOD_Encoder\metadata 

Archive Folder The local location of the folder where metadata files that 
already transferred are stored 

Default is 

C:\Nielsen\RTVOD_Encoder\arch_metadata 

Server Address Address of your local Server setup for File Transfer to 
Nielsen 

Server Login Login of your local Server setup for File Transfer to 
Nielsen 

Server Password Password of your local Server setup for File Transfer to 
Nielsen 

Remote Folder The folder on your transfer server where the metadata 
files are stored before transfer to the CF 

 
 

4. Click Save and close the window. Files are sent on the set interval. 

  



 RTVOD Encoding Application User Manual 

 

 32 Nielsen Confidential 

 

(Optional) Configuring the File Trigger Service 

The RTVOD File Trigger application is automatically installed during the RTVOD Content 
Encoder application installation. This is an optional service that you can use to automatically 
trigger file encoding. 

The File Trigger Service monitors a “watch” folder that contains an XML trigger file that 
initiates encoding with the content identified in the file. After each file is encoded, the File 
Transfer Manager Service (RTVODFTMService.exe) detects the metadata files generated by 
the File Trigger Manager Service and then uses SFTP to send the files to the CF (Collection 
Facility). The configuration application creates a configuration file that it places in the “etc” 
directory where the Encoder is installed. 

For more details on the File Trigger Service, see “Transferring Metadata to the Nielsen 
Collection Facility” on page 8. 
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Configuring the Trigger Service to Run Manually 

1. From the Windows Start  menu, select Nielsen  > RTVOD File Trigger Manager . 

2. On the File Trigger Manager  window, browse to the XML File Path  to the trigger file 
watch folder. See Figure 22. 

Note The Appendix shows examples of the XML files. 

3. Browse to the Scratch  folder.  

4. Click Save Config . 

Note If the Monitor File Trigger Service checkbox is checked in the 
RTVODServicesMonitorTool dialog box, the RTVOD File Trigger Manager 
service automatically restarts. 

 

Figure 22 – File Trigger Manager Window 

Configuring the File Trigger Service to Run Automatically 

1. To start automatically after reboot, open the Control Panel . 

2. Select Administrative Tools > Services . 

 

Figure 23 – Administrative Tools > Services 

3. Right-click NIELSEN RTVOD File Trigger Service  and select Properties  from the menu. 
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Figure 24 – File Trigger Service in Services 

4. In Startup  type on the Properties  window, select Automatic . 

 

Figure 25 – File Trigger Service Properties 

5. Click OK. 
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Encoding and Decoding 

Encoding Using the GUI 

1. Launch the RTVOD Encoding App. 

2. If feed-point transfer parameters have not been set, the feed-point transfer 
parameters screen will be displayed.  For first time set-up, refer to Table 3  to set 
feed-point transfer parameters.  You will not have to repeat the feed-point transfer 
parameter set-up again unless you want to make changes.  This configuration 
window is accessed from the main menu, Configure -> System Setup. 

 

Figure 26 – Encoder Configuration Feed-Point Transfer Parameters 

3. In order to allow RTVOD tagging of a video asset that contains AC3 audio frame 
errors (artifacts from recording for example), enter the number of AC3 frame errors 
that are to be ignored. 

In the example shown, the AC3 audio frame error threshold is set to 3, which means 
the RTVOD App (GUI, command-line and File Trigger) will ignore up to and including 
3 AC3 audio frame errors found during encoding or decoding.  If a 4th AC3 frame 
error is found, processing will stop. 

Note The AC3 frame error threshold defaults to 0 and can be set up to a maximum of 128. 

Important Do not input an AC3 audio frame error threshold greater than 128. Due to 
processing limits, entering a value from 129 to 2147483647 will result in a 
warning and will not allow you to save the value.  Entering a value above 
2147483647 will result in the AC3 audio frame defaulting to 0 and there will not 
be any warning or error message. 

4. Click SAVE. 
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5. If Encoding Profile Configuration has not been set, the Encoding Profile Configuration 
window will display. 

6. For first time set-up, refer to “Maintaining the Encoder” on page 56 to add, delete, or 
edit the encoding profile configuration.  You will not have to change the encoding 
profile configuration again unless you want to make changes. 

 

 

 

Figure 27 – Encoding GUI Profile Configuration 

 

7. Click APPLY to accept configuration or CANCEL  to discard changes when done. 
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8. When the RTVOD Encoding App is running, the main window will display. 

 

 

Figure 28 – Encoding GUI App Main Window 

9. Click on the SOURCE VIDEO tab. 

10. Select the RTVOD profile from the profile combo list. 

11. Select the file to encode from the list of files. 

12. Click on ENCODE to start encoding. 

13. The feed-point input information window will display. 
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Figure 29 – Encoding GUI Asset Input Feed-Point Information 

 

14. You can make changes, or accept the default feed-point parameters. 

15. Click OK to continue, or click CANCEL  to exit to the main encoding window. 

16. If you continue, the encoding progress window will display. 
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Figure 30 – RTVOD Encoding Progress Window 

17. If you click CLOSE or CANCEL , you will exit to the main menu. 

18. If encoding was in progress, there will be an error message displayed indicating the 
encoding was aborted by the user. 

19. If encoding ends, only the CLOSE button will display. 
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Figure 31 – RTVOD Encoding Tab Window 

20. While encoding session is in progress, there are three possible errors that could 
happen.  There are views of the three error messages. 

 

 

Figure 32 – NW Clean Asset Encoding error 
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Figure 33 – RTVOD Already present in Asset error 

 

 

Figure 34 – No Slot available to encode error  
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21. After PreEncoding analysis is done the encoding progress window will display as 

shown below. 

 

 

Figure 35 – RTVOD Encoding Progress Window 
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22. The encoding succeeded window will display at the end of a successful encoding 
session, as shown below.  Click OK to proceed. 

 

 

Figure 36 – RTVOD Encoding Success Window 

23. Click CLOSE to exit to the main menu. 
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Decoding Using the GUI 

To verify that encoding occurred, and that TICs were inserted, decode the encoded file. 

1. Launch the RTVOD Decoding App. 

2. When the RTVOD Decoding App is running, the main window will display. 

 

Figure 37 – GUI Decoding Tab 

3. Click on the ENCODED VIDEO tab. 

4. Select the RTVOD profile from the profile combo list. 

5. Select the file to decode from the list of files. 

6. Click on DECODE to start decoding. 

7. The decoding progress window will display as shown below. 
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Figure 38 – GUI Decoding Progress Window 

 

 

8. The decoding complete window will display at the end of a successful decoding 
session, as shown below. 
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Figure 39 – GUI Decoding Complete Window 

 

9. Click CLOSE to exit to the main menu. 
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RTVOD Services Monitor Tool 

The RTVOD Services Monitor Tool monitors either the File Transfer Service or the File 
Trigger Service or both, depending on what is selected.  While monitoring a service, if that 
service is detected to stop running, the Services Monitor Tool will restart the service.  The 
Services Monitor Tool also monitors the File Transfer log and will generate a pop-up 
message in the event of a file transfer error as logged by the File Transfer Service.  This pop-
up message can be disabled. 

1. The RTVOD Services Monitor Tool is used to selectively monitor the file transfer 
service and the file trigger service.  If one of these monitored services is found to not 
be running, it will be started by the service monitor tool. 

 

Figure 40 – RTVOD Services Monitor Tool 

2. Check the “Monitor File Transfer Service” checkbox to monitor the File Transfer 
Service (selected by default). 

3. Check the “Monitor File Trigger Service” checkbox to monitor the File Trigger 
Service. 

4. Check the “Turn Off Error Popup” checkbox to stop the Services Monitor Tool from 
generating pop-up messages in the event of file transfer errors. 
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On Windows Server 2008 32-bit platforms, the UAC (User Account Control) may block 
the RTVOD Services Monitor Tool from starting automatically on boot-up.  If so, you 
should see a pop-up in the Windows Tray to notify you of this. 

 

Figure 41 – Windows blocked startup programs 

Click on the blocked programs ICON in the Windows tray.  Click “Run blocked program” 
and then click “RTVOD Services Monitor Tool”. 

 

Figure 42 – Allow the RTVOD Services Monitor Tool to run 
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Encoding Using the Command Line 

The command-line version of the RTVOD Content Encoder is called ContentCodeCmd. 
ContentCodeCmd enables you to automate encoding and decoding. 

Note You can also automate file transfer. For more information, see “Transferring Metadata to 
the Nielsen Collection Facility” on page 8. 

ContentCodeCmd Arguments 

The RTVOD Encoder package includes a batch file, InsertContentCodes.bat, which includes 
a call to ContentCodeCmd.exe. You may edit the command line arguments in this .bat file to 
meet your requirements, and then execute the .bat file to conduct a single watermarking 
session. 

Table 5 – Encoding Command Line Arguments 

Argument Description 

rtvodtype  RTVOD flag type C3 or C7 that indicates live telecast plus 3 days 
(C3) or live telecast plus 7 days (C7) 

input Full path name of the file containing the MPEG-2 transport stream to 
be watermarked 

output Full path name of the generated watermarked file 

clientname The name of the client related to the asset 

assetid String for content to be encoded, if not specified default value used 

asset name Descriptive name for content to be encoded; passed to the CF in the 
feed-point metadata file, if not specified default value used 

episode String for the episode to be encoded, if not specified default value 
used 

adifile Full path name for CableLabs-compliant file to be transferred to the 
CF 

Encoding Command Line Format 

When using ContentCodeCmd to encode, use this format to set the parameters described 
above: 

ContentCodeCmd   

-rtvodtype <C3 or C7> 

-input <input file> 

-output <output file> 

[-clientname <client name>][-assetid <asset ID>] 

[-asset name <asset name>] 

[-episode <episode ID>] 

[-adifile <ADI file name>] 



 RTVOD Encoding Application User Manual 

 

 50 Nielsen Confidential 

Encoding Example 1 

This example shows how to encode “C:\MPEGFILES\Unprocessed\test.mpg” with a 
RTVOD flag C3 and store the encoded file in “C:\MPEGFILES\Processed\test.mpg.”. 

ContentCodeCmd –rtvodtype c3 -input 

"C:\MPEGFILES\Unprocessed\test.mpg"-output 

C:\MPEGFILES\Processed\test.mpg –clientname “XYZ” - assetid "54321" -

assetname "InterestingClip" –episode “Episode 1”  

Decoding Using the Command Line 

You can also use ContentCodeCmd to decode Nielsen-encoded files, display the results on 
the screen, or send them to a file. ContentCodeCmd reports the results in this format. 

<stream offset>, <SID>, <code type>, <audio PID>, < TIC/timestamp> 

The RTVOD Encoder package includes a batch file, DisplayCodes.bat, which contains a call 
to ContentCodeCmd.exe. You may adjust the command-line arguments in this .bat file to 
meet your requirements and then execute the .bat file to conduct a single decoding session. 

Table 6 – Decoding Parameters 

Parameter Description 

Stream offset Offset from the beginning of the stream where the end of the Nielsen 
watermark is located. The <stream offset> is expressed as  
hours : minutes : seconds 

SID Nielsen source identifier 

Code type PC” for program content or “FD” for final distributor. The VOD Content 
Encoder inserts “PC” watermarks. If the decoder reports “FD” watermarks, 
those watermarks were inserted by other Nielsen encoder 

Audio PID MPEG PID that identifies the AC-3 or AES PCM stream in which the Nielsen 
watermark was found 

TIC/Timestamp Numeric value that identifies a specific segment of the encoded asset. Each 
four-second segment of code has its own unique TIC or timestamp 

 

Table 7 – Decoding Command Line Arguments 

Argument Description 

-decode Activity the tool should do 

-input Full path name of the file to be decoded 

The following is an example of decoding a file, “C:\MPEGFILES\Processed\test.mpg,” and 
storing the report in a file, “C:\Temp\decoder_out.txt,” while displaying the report on the 
screen:  

ContentCodeCmd –decode –input “C:\MPEGFILES\Process ed\test.mpg”  
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Transferring Metadata Files to the Nielsen CF 

For crediting, your plant must transfer metadata files to the Nielsen CF.  There are several 
possible ways to transfer the files: through the content encoder itself, using the File Transfer 
Manager application, or using the File Trigger Service to manually or automatically transfer 
the files. 

Transferring Files to CF Using the RTVOD Content Encoder 
GUI 

1. On the File  menu in the RTVOD Content Encoder  application, select Transfer . All files 
in the metadata directory (as configured) transfer to the CF or the Local Service, 
depending on your configuration. 

 

Figure 43 – RTVOD Content Encoder File Transfer Menu Item 
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2. When the file transfer is being executed from either the RTVOD Content Encoder 
App or the RTVOD File Transfer Manager you will see a pop-up window in which the 
curl process runs as shown in Figure 44.  When the File Transfer Service transfers 
files, this pop-up window will not appear. 

 

Figure 44 – Pop-up window showing curl process 
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Transferring Files to CF Using the File Transfer Manager 

1. In the File Transfer Manager  application, select the Transfer to Data-Collection Facility  
transfer mode. 

2. In the File Transfer Manager  application, click the Transfer Files  button. All files in the 
metadata directory transfer to the CF. 

 

Figure 45 – RTVOD File Transfer Manager 

3. When the file transfer completes successfully, the Content Encoder App indicates 
success in the status field as shown in Figure 46. 
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Figure 46 – RTVOD Content Encoder App File Transfer Success 

4. When the file transfer completes successfully, the Content Encoder App indicates 
success in the status field as shown in Figure 47. 

 

 

Figure 47 – RTVOD File Transfer Manager File Transfer Success 
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Encoding Files Using the File Trigger Service 

Manually Start File Trigger Service 

1. From the Windows Start  menu, select Nielsen > RTVOD File Trigger Manager  as shown 
in Figure 48. 

 

Figure 48 – RTVOD File Trigger Manager In Start Menu 

2. The file trigger manager window will appear as shown in Figure 49.  Click Start 
Service . The File Trigger Service runs until you stop it or reboot the system. 

 

Figure 49 – File Trigger Manager Window 

Note If the Trigger Service fails while processing a trigger file, it renames the trigger 
file (appending the ".failed" extension) instead of deleting the file. The Trigger 
Service does not attempt to process the renamed trigger file until the extension in 
the file name is changed to xml. 

Note If the Monitor File Trigger Service checkbox is checked in the RTVOD 
ServicesMonitorTool dialog box, the RTVOD File Trigger Service automatically 
restarts. 

3. To stop the File Trigger Service , click Stop Service . 

4. Close the window. 

Automatically Start File Trigger Service 

See “Configuring the File Trigger Service to Run Automatically” on page 33. 
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Maintaining the Encoder 

This section covers procedures that you may periodically do. 

Adding a Profile 

1. From the Main RTVOD GUI, click on the Menu Item Configure->Profile Setup  to open 
the profile editor window. 

2. On the Profile Editor window, click on the Add  button to add a new RTVOD encoding 
profile. 

3. Select the RTVOD EncodeType  (C3 or C7) from the combo list. 

4. Enter Profile Name , ClientName  and browse to specify the Source, Encoded and ADI 
file paths. 

5. Click Apply  to save the encoding profile and exit, or click cancel  to exit without 
saving. 

 

Figure 50 – Adding a Profile 
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6. The newly added profile will be visible in Profile List. 

 

Figure 51 – New Profile Visible in Profile List 

 

Editing a Profile 

1. From the Main RTVOD GUI, click on the Menu Item Configure->Profile Setup  to open 
the profile editor window. 

2. On the Profile Editor window, select the profile name in Profile List  to edit the existing 
profile. 

3. On the Profile Editor window, click on the Edit  button to edit the RTVOD encoding 
profile. 

 

 

Figure 52 – Selecting a Profile to Edit 
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4. If needed change the RTVOD Encode Type  from the combo list. 

5. If needed browse to change the location of the Source, Encoded and ADI file path. 

6. Click Apply  to save the modified profile and exit, or Cancel  to exit without saving. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 53 – Saving and Edited Profile 
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Deleting a Profile 

1. From the Main RTVOD GUI, click on the Menu Item Configure->Profile Setup  to open 
the profile editor window. 

2. On Profile Editor window, select the profile name in Profile List  to delete the existing 
profile. 

3. On the Profile Editor window, click on the Delete  button to delete the RTVOD 
encoding profile. 

4. On the Profile Deletion Warning Message popup, click OK to continue. 

5. Click on Apply  to permanently delete the profile, or else Cancel  to exit without 
deleting.  

 

Figure 54 – Deleting a Profile 

NOTE: 

The RTVOD Encoder App will not operate without at least one valid profile, so you will find 
that it will not successfully delete all of the profiles from the GUI App.  If you really want to 
delete all of the profiles, close the RTVOD Encoder GUI App and delete the following file: 
“C:\Nielsen\RTVOD_Encoder\etc\ProfileConfig.txt”.  The next time you start the RTVOD 
Encoder GUI App, it will display an error message warning that no valid profiles exist and 
start the profile editor for you. 

 

 

Updating Default AssetInfo (Feedpoint Parameters) 

1. From the Main RTVOD GUI, click on the Menu Item Configure->AssetInfo Setup  to 
open the feedpoint parameters configuration window. 

2. You can update default values for AssetId, AssetName and EpisodeID. Refer to 
Table 1 for feedpoint parameter descriptions. 

3. Click save to update the feedpoint parameters/Asset information. 
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4. Press cancel to keep the default values “MyAssetId”, “MyAssetName” and 
“MyEpisodeID”. 

 

 

 

 

 

 

 

 

 

 

 

Figure 55 – Updating AssetInfo 
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Troubleshooting 

Encoder Services Are Not Running or Repeatedly Fail 

Important RTVOD Content Encoder applications should only be installed on systems used 
solely for Nielsen encoding.  To permit the encoding software to run without 
interference, antivirus and firewall programs should be disabled. If disabling is 
not possible, the security software must be configured to permit the files listed in 
the procedure below to run. 

Certain Internet security virus-protection applications may interfere with the RTVOD Content 
Encoder services and produce any or all of the following issues: 

 File Transfer Service is not running or its function does not automatically occur. �

 After successful installation of the Encoder application, the FTM and/or File Trigger.exe �

files disappear. 

When these issues could be related to antivirus software (see the rest of the 
“Troubleshooting” for other, potential causes), do the following: 

1. To see whether your antivirus software may be interfering with the encoding 
software, do the following: 

a. Open the history feature in the antivirus program. 

b. Examine the events for evidence of the encoder services stopping or failing. 

2. Add the following files to the “exclude” or “trust” feature in your antivirus program. 

On a computer installed 
with... 

Trust or exclude this file in 
antivirus software: 

RTVOD Content Encoder RTVODFileTrigger.exe 

RTVODFTMService.exe 

RTVOD File Transfer Manager RTVODFTMService.exe 

 
3. Reboot your system. 

4. In Windows Control Panel  (or equivalent), select Administrative Tools . 

5. Select Services  and ensure that all of the following that apply to your system are 
operating correctly: 

o NIELSEN FILE TRANSFER MANAGER SERVICE Status is Started. 

o NIELSEN RTVOD File Trigger Service Startup Type is Manual. 

6. If any services are missing, do the following: 

o In Windows 7  or Windows Server , do the following: 

a. Select All Programs > Nielsen  and right-click RestoreNielsenServices . 

b. Select Run As Administrator . 

7. Ensure that the ServicesMonitorTool  is running and the corresponding services check 
box is checked. 
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Errors Creating ZIP files  

The metadata folder and archive folder must not be located under either the “C:\Program 
Files\” or “C:\Program Files (x86)\” directories.  They may be located on other hard disks and 
the default location is as follows: 

C:\Nielsen\RTVOD_Encoder\metadata 

C:\Nielsen\RTVOD_Encoder\arch_metadata 

Files or Codes Are Missing  

Use these steps to uncover root causes when encoding is not successful. 

MPEG Files Missing on Source Video Tab 

It may be that the incorrect profile for this encoding session was selected or you may need to 
create a new profile with the correct video source path. 

1. Do one of the following: 

o Ensure that the Video Source Path  specifies the location of the file that you would 
like to encode. See “Editing a Profile” on page 57. 

o Create a new profile. See “Adding a Profile” on page 56. 

Missing Files on the Encoded Video Tab 

An incorrect profile for this decoding session may have been selected. 

1. See “Editing a Profile” on page 57. 

2. Ensure that the Encoded File Path  specifies the full path name of the file that you just 
encoded.  

Unable to Create or Write to the Output File 

Ensure that the encoded path that you selected is not read-only. 

Missing or Few RTVOD Watermarks When File is Decoded 

If the content was difficult to encode (very quiet, for example) or if the AC-3 stream bit rate 
was too low, the Encoder may not have been able to insert as many audio codes as 
expected.  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 
Installation and Configuration Policy.  

Nielsen Unable to Detect Watermarks in Encoded File  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 
Installation and Configuration Policy.  
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Ensure that you pitched the encoded file, not the original source file. 

Encoding Takes Too Long 

Ensure that other processes are not tying up the encoding system. Transferring large files to 
or from the Encoder host computer, for example, is very likely to slow the encoding process. 

Services Monitor Tool Fails to Start on Boot 

Due to a bug in the Windows 7 32-bit Operating System, programs do not always launch 
when entered in the Windows registry under the key 
“HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run”.   

After rebooting a Windows 7 32-bit system, if the Services Monitor Tool fails to start, it will be 
necessary to start it manually “as Administrator”. 

1. Open a file Explorer window and navigate to the directory “C:\Program 
Files\Nielsen\RTVOD_Encoder”. 

2. Right-click on the file “ServicesMonitorTool.exe” and select “Run as administrator” 
from the pop-up menu. 

 

Figure 56 – Run ServicesMonitorTool as admin 
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TIC/CF Request Failed or Unable to establish valid connection 

To start an encoding session, the Encoder must first establish a network connection to a 
properly configured, active TIC/CF Server. Even if the Server resides on the same computer 
as the Encoder, the Server and the Encoder application communicate. Communication 
issues may occur that prevent encoding from taking place.  

If you see an error message, use the following steps to look for root causes. 

1. Communications with Nielsen Fail 

Check your firewall to ensure it is not preventing communications between the Server 
and the Encoder. 

2. "File Not found on TFTP server"  

If the server login user or password are not correct, you may get the error message 
"File Not found on TFTP server".  This error message is returned from the “curl” 
subsystem and be confusing. 
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Troubleshooting Issues with Transferring Metadata 

The RTVOD Encoder File Transfer Service periodically transfers any available feed-point 
metadata files to the Nielsen CF. Follow these steps when metadata has not properly 
transferred. 

Verifying the File Transfer Service Is Correctly Operating 

1. In the FTM application, select View > Log File . 

2. Scroll through the log file and search for any of the following messages: 

o This message indicates that a file was successfully transferred to the CF at the 
time that the message was sent. 

FTM: Transfer succeeded, 1 files transferred. 

o This message indicates that no files have been transferred since the last 
message from the File Transfer Manager. In the absence of other, more specific 
error messages, however, this is not an error report. Instead, it merely indicates 
that there were no feed-point metadata files ready to be transferred.  

FTM: No files found to transfer.  

o An error message in the error log or no reports from the File Transfer Manager 
over a long period indicates File Transfer Service may not be properly 
functioning.  See “Verifying the File Transfer Manager Service Is Running” on 
page 65. 

Verifying the File Transfer Manager Service Is Running 

1. To ensure that the File Transfer Manager Service  is running, in the Control Panel , open 
Administrative Tools > Services . 

2. In the Services  list, locate Nielsen File Transfer Manager Service  and do one of the 
following: 

o If File Transfer Manager Service  does not appear in the list, the Encoder software 
was not properly installed. Uninstall and reinstall the software as follows: 

• Uninstall and reinstall FTM. 

o If the File Transfer Manager Service  DOES appear in the list (#2 in Figure 23), 
check the Status  of the Trigger Service  and do one of the following: 

• If the Status  is not Started , right-click the File Transfer Manager Service  list 
entry and select Start . 

• If the Status  of the File Transfer Manager Service  is Started , go to the next 
step. 

3. From the View  menu on the RTVOD Encoder  window, select Configure > System 
Setup . 

4. In the RTVOD File – Transfer Configuration  window (Figure 21), verify the values are 
correct. See also Table 3 – Feed-Point Transfer Parameters on page 31. 

5. Click Save. 
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6. On the File  menu in the Encoder  window, select Transfer . If all components are 
properly configured, all files should transfer from the metadata folder to the CF and 
the original files to the arch_metadata folder. A message should confirm that the 
transfer was successful. If the transfer fails, do the following: 

o Check the network configuration and firewall settings on the Encoder. 

o Verify that a third-party FTP application is NOT running on the same subnet as 
the File Transfer Service  by doing the following: 

a. In Control Panel  (or equivalent), open Administrative Tools > Services . 
See Figure 23. 

b. Examine the Services  list to see if an FTP application other than the 
Nielsen File Transfer Manager Service  is running. 

c. If an FTP application is running, to prevent the application from auto-
starting during boot up, do the following: 

a. Right-click the name of the application and select Properties . 

b. Change the Startup Type  to Disabled . 

Important If File Transfer Manager Service problems persist, call Nielsen Encoder Support 
to check the status of the metadata server at the Collection Facility. See 
“Customer Support” on page 5. 

Note If only the RTVOD Encoder software is installed by itself, the Services Monitor 
Tool will by default record errors in the log that it “Failed to start the service 
RTVODFTMService”.  To stop these error messages, install the File Transfer 
Manager.  See “Installing the File Transfer Manager” on page 22. 
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Appendix 

Contents of an XML Trigger File 

The following is an example of a Sample-File-Trigger.xml file.  Refer to Table 1 for feedpoint 
parameter descriptions. 

<ContentEncodingParams> 

 <InputFile>   

  C:\temp\VoD\Source\Sample.mpg   

 </InputFile> 

 <OutputFile>  

  C:\temp\VoD\Encoded\Sample-enc.mpg  

 </OutputFile> 

 <RTVODEncType> 

  C3 

 </RTVODEncType> 

 <AssetId> 

  Test ID 1 

 </AssetId> 

 <AssetName> 

  This is for File Trigger Encode Test. 

 </AssetName> 

 <EpisodeId> 

  Episode 1 

 </EpisodeId> 

 <ClientName> 

  Enter the client name here 

 </ClientName> 

</ContentEncodingParams> 
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Contents of an ADI File Trigger XML File 

The following is an example of a Sample-ADI-File-Trigger.xml file. For definitions of the 
parameters, see Table 2 – Parameters Defined for Standard XML File-Encoding on page 11. 

<ContentEncodingParams> 

 <InputFile> 

  C:\temp\VoD\Source\Sample.mpg 

 </InputFile>  

  <OutputFile> 

  C:\temp\VoD\Encoded\Sample-enc.mpg 

 </OutputFile>  

  <AdiFile> 

  C:\temp\VoD\ADI\Sample-ADI.XML 

 </AdiFile>  

  <SID> 

  9000 

 </SID>  

  <AssetId> 

  TEST0001137522386093 

 </AssetId>  

  <AssetName> 

  TEST24S04E01_Title 

 </AssetName>  

</ContentEncodingParams> 



 RTVOD Encoding Application User Manual 

 

 69 Nielsen Confidential 

CURL EXIT CODES 

 

There are a several error codes and their corresponding error messages that may appear 
during bad conditions. At the time of this writing, the exit codes are: 

  

0 The curl command succeeded. 

1  Unsupported protocol. This build of curl has no support for this protocol. 

2  Failed to initialize. 

3  URL malformed. The syntax was not correct. 

4  A feature or option that was needed to perform the desired request was not enabled or 
was explicitly disabled at build-time. To make curl able to do this, you probably need another 
build of libcurl! 

5  Couldn’t resolve proxy. The given proxy host could not be resolved. 

6  Couldn’t resolve host. The given remote host was not resolved. 

7  Failed to connect to host. 

8  FTP weird server reply. The server sent data curl couldn’t parse. 

9  FTP access denied. The server denied login or denied access to the particular resource 
or directory you wanted to reach. Most often you tried to change to a directory that doesn’t 
exist on the server. 

10  

11  FTP weird PASS reply. Curl couldn’t parse the reply sent to the PASS request. 

12  

13  FTP weird PASV reply, Curl couldn’t parse the reply sent to the PASV request. 

14  FTP weird 227 format. Curl couldn’t parse the 227-line the server sent. 

15  FTP can’t get host. Couldn’t resolve the host IP we got in the 227-line. 

16  

17  FTP couldn’t set binary. Couldn’t change transfer method to binary. 

18  Partial file. Only a part of the file was transferred. 

19  FTP couldn’t download/access the given file, the RETR (or similar) command failed. 

20  

21  FTP quote error. A quote command returned error from the server. 

22  HTTP page not retrieved. The requested url was not found or returned another error with 
the HTTP error code being 400 or above. This return code only appears if -f, --fail is used. 

23  Write error. Curl couldn’t write data to a local filesystem or similar. 

24  

25  FTP couldn’t STOR file. The server denied the STOR operation, used for FTP uploading. 
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26  Read error. Various reading problems. 

27  Out of memory. A memory allocation request failed. 

28  Operation timeout. The specified time-out period was reached according to the 
conditions. 

29  

30  FTP PORT failed. The PORT command failed. Not all FTP servers support the PORT 
command, try doing a transfer using PASV instead! 

31  FTP couldn’t use REST. The REST command failed. This command is used for resumed 
FTP transfers. 

32  

33  HTTP range error. The range "command" didn’t work. 

34  HTTP post error. Internal post-request generation error. 

35  SSL connect error. The SSL handshaking failed. 

36  FTP bad download resume. Couldn’t continue an earlier aborted download. 

37  FILE couldn’t read file. Failed to open the file. Permissions? 

38  LDAP cannot bind. LDAP bind operation failed. 

39  LDAP search failed. 

40  

41  Function not found. A required LDAP function was not found. 

42  Aborted by callback. An application told curl to abort the operation. 

43  Internal error. A function was called with a bad parameter. 

45  Interface error. A specified outgoing interface could not be used. 

46  

47  Too many redirects. When following redirects, curl hit the maximum amount. 

48  Unknown option specified to libcurl. This indicates that you passed a weird option to curl 
that was passed on to libcurl and rejected. Read up in the manual! 

49  Malformed telnet option. 

50  

51  The peer’s SSL certificate or SSH MD5 fingerprint was not OK. 

52  The server didn’t reply anything, which here is considered an error. 

53  SSL crypto engine not found. 

54  Cannot set SSL crypto engine as default. 

55  Failed sending network data. 

56  Failure in receiving network data. 

57  

58  Problem with the local certificate. 

59  Couldn’t use specified SSL cipher. 
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60  Peer certificate cannot be authenticated with known CA certificates. 

61  Unrecognized transfer encoding. 

62  Invalid LDAP URL. 

63  Maximum file size exceeded. 

64  Requested FTP SSL level failed. 

65  Sending the data requires a rewind that failed. 

66  Failed to initialise SSL Engine. 

67  The user name, password, or similar was not accepted and curl failed to log in. 

68  File not found on TFTP server.  (NOTE: This message may appear if the server login 
user or password are incorrect) 

69  Permission problem on TFTP server. 

70  Out of disk space on TFTP server. 

71  Illegal TFTP operation. 

72  Unknown TFTP transfer ID. 

73  File already exists (TFTP). 

74  No such user (TFTP). 

75  Character conversion failed. 

76  Character conversion functions required. 

77  Problem with reading the SSL CA cert (path? access rights?). 

78  The resource referenced in the URL does not exist. 

79  An unspecified error occurred during the SSH session. 

80  Failed to shut down the SSL connection. 

81  

82  Could not load CRL file, missing or wrong format (added in 7.19.0). 

83  Issuer check failed (added in 7.19.0). 

84  The FTP PRET command failed 

85  RTSP: mismatch of CSeq numbers 

86  RTSP: mismatch of Session Identifiers 

87  unable to parse FTP file list 

88  FTP chunk callback reported error 

89  No connection available, the session will be queued 

90  SSL public key does not matched pinned public key 
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ZIP EXIT CODES 

 

There are a several error codes and their corresponding error messages that may appear 
during bad conditions. At the time of this writing, the exit codes are: 

  

0 Normal; no errors or warnings detected. 

1   

2 The zipfile is either truncated or damaged in some way (e.g., bogus internal offsets) that 
makes it appear to be truncated. 

3 The structure of the zipfile is invalid; for example, it may have been corrupted by a text-
mode ("ASCII") transfer. 

4 Zip was unable to allocate sufficient memory to complete the command. 

5 Internal logic error. (This should never happen; it indicates a programming error of some 
sort.) 

6 ZipSplit was unable to create an archive of the specified size because the compressed 
size of a single included file is larger than the requested size. (Note that Zip and ZipSplit 
still do not support the creation of PKWARE-style multi-part archives.) 

7 The format of a zipfile comment was invalid. 

8 Testing (-T option) failed due to errors in the archive, insufficient memory to spawn 
UnZip, or inability to find UnZip. 

9 Zip was interrupted by user (or superuser) action. 

10 Zip encountered an error creating or using a temporary file. 

11 Reading or seeking (jumping) within an input file failed. 

12 There was nothing for Zip to do (e.g., "zip foo.zip"). 

13 The zipfile was missing or empty (typically when updating or freshening). 

14 Zip encountered an error writing to an output file (typically the archive); for example, the 
disk may be full. 

15 Zip could not open an output file (typically the archive) for writing. 

16 The command-line parameters were specified incorrectly. 

17  

18 Zip could not open a specified file for reading; either it doesn't exist or the user running 
Zip doesn't have permission to read it. 
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Glossary 

A 

ADIFileName 

The name of the CableLabs file (if any) that will be transferred to the Nielsen Data-Collection Facility along with the 
NMR Feed-Point Metadata File. 

ADI-XML File 

The ADI.XML file holds parameters (MPEG file name, asset name, asset ID, episode ID) used in content encoding. In 
tar-file processing, the File Trigger Service extracts a set of encoding parameters from the ADI.XML file before 
starting the encoding session. When the tar-file encoding session ends successfully, the Trigger Service modifies the 
ADI file, updating the MPEG file name and the checksum to correspond to the newly encoded MPEG file. 

AssetId 

The ID of the encoded content. May be derived from an Asset ID field in the CableLabs file. 

AssetName 

The name of the encoded content. May be derived from an Asset Name field in the CableLabs file. 

C 

CF 

Nielsen Collection Facility. 

CURL 

An open source file transfer tool.  http://curl.haxx.se/docs/manpage.html 

D 

Decoder 

An application that processes an audio stream (PCM or AC-3) and reports on the Nielsen watermarks (NAES II, NW, 
or both) that it finds in the audio stream. 

E 

Ending TIC 

The value of the last TIC reserved for this asset. 
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F 

FD 

Final Distributor. An attribute in watermark that identifies the watermark as inserted by a distributor. 

FileSizeBytes 

The size of the encoded file in bytes. 

FileSizeSeconds 

The approximate duration (in seconds) of the encoded file. This is just an approximation. For very long files, the 
estimated size may be incorrect by several seconds. 

N 

NAES II (Nielsen Audio Encoding System II) 

Also known as NAES II. The second-generation method of inserting a SID (Nielsen source identifier) and time stamp 
into a TV signal. 

NW (Nielsen Watermarks) 

A Nielsen technology that places an audio watermark in a lower-frequency portion of the active program than does 
NAES II technology. Its lower-frequency position enables NW to be more robust and much less likely to be 
“compressed out” of the program audio by TV distribution providers without interfering with the viewer’s listening 
experience. Unlike NAES II, however, NW code cannot be overwritten by successive program distributors. 

P 

PC (Program Content) 

An attribute in a watermark that identifies the watermark as inserted by a programming source. 

S 

SID (Source Identifier) 

Unique identifier that Nielsen assigns to each subscriber (or distribution source) using audio watermarking. Included 
as a component of each watermark, the SID uniquely identifies the distribution source. A subscriber may have more 
than one SID. 

StartingTIC 

The value of the first TIC reserved – and the first TIC inserted into this asset. 

T 
TIC (Time in Code)  

A time code used for encoding offline content. See Time Stamp. 
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Time Code 

See Time Stamp. 

Time Stamp  

A component of the watermark that identifies one of two attributes: 

 A numeric representation of the date and time at which the watermark was inserted in the stream (referred �

to as a timestamp or time code, and typically used when streaming content is watermarked as it is being 
broadcast). 

 A numeric representation of the time-in-content (referred to as a TIC, and typically used when watermarking �

audio content that is stored in a file). By subtracting the starting TIC from the TIC extracted from the 
watermark, one can determine how many seconds into the stored file the watermark is located. 

In NAES II watermarking, the timestamp or TIC is represented as a 32-bit unsigned integer. The timestamp in Nielsen 
watermarking uses only 29 bits. 

Trigger File 

An XML file the presence of which in a specific folder triggers the start of a RTVOD content encode. 

W 

Watermark 

Used as a noun, also referred to as an audio code, a watermark is a sequence of bits that the Nielsen Watermark 
software inserts periodically in an audio stream. The components of the watermark (SID, timestamp or TIC, and a PC 
or FD flag to identify the point of entry into the flow of content distribution). With these components, a watermark can 
uniquely identify the portion of audio from which the watermark is extracted, that is, the distribution source to which 
the audio content can be credited.  

Used as a verb, the term “to watermark” means to insert Nielsen codes into an audio stream. 
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